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Preface

This section describes the purpose and organization of this guide: Oracle Enterprise
Manager Getting Started with the Oracle Standard Management Pack. Specifically, it
covers the following topics:

■ Purpose of This Guide

■ Audience

■ How This Guide Is Organized

■ Conventions Used in This Guide

■ Oracle Enterprise Manager Pack Information

■ Oracle Enterprise Manager Documentation

Purpose of This Guide
This guide provides an overview of the Oracle Standard Management Pack
applications and their features.  As the guide describes how to use the Oracle
Standard Management Pack applications, it also introduces you to key concepts and
terminology in the following products: Oracle Performance Manager, Oracle Index
Tuning Wizard, Oracle DB Capture, Oracle DB Diff, and Oracle TopSessions.

Audience
This guide is written for the Oracle Standard Management Pack users who want to
monitor and diagnose problems, tune high impact indexes, and track and compare
changes in their Oracle environment.
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How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Overview"

Provides a general description of the Oracle Standard Management Pack.

Chapter 2, "Introduction to Oracle Performance Manager"

Provides an overview of the Oracle Performance Manager application and its
features.

Chapter 3, "Introduction to Oracle Index Tuning Wizard"

Provides an overview of the Oracle Index Tuning wizard.

Chapter 4, "Introduction to DB Capture and DB Diff"

Provides an overview of the DB Capture and DB Diff applications and their
features.

Chapter 5, "Using Oracle TopSessions"

Provides an overview of the Oracle TopSessions application and its features.

Conventions Used in This Guide
The following table  lists the conventions used in the guide.

Convention Explanation

# The default superuser prompt.

% The default user prompt.

[Ctrl/C] Press the Ctrl key while you simultaneously press another key
(in this case, C).

italics Italicized words indicate variables, such as a file or directory
name.

$ORACLE_HOME Represents the directory where you installed Oracle Enterprise
Manager components and the Oracle Standard Management
Pack applications.  The directory name may be different on your
system.

otracexx The xx represents the version of the database for which you are
collecting data; for example, otrace73 for the Oracle Server
release 7.3.
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This guide also assumes that you are familiar with the operation of Microsoft
Windows NT. Refer to the Windows documentation for your system, if necessary. In
general, this guide shows the directory names as they are used in UNIX; on an NT
system, delineate directory names with a backslash (\).

To reduce wordiness and redundancy, menu and submenu choices are joined by
arrows. For example, Collection=>Create refers to the Create Collection choice in
the Collection menu.

Oracle Enterprise Manager Pack Information
The Oracle Enterprise Manager product family includes four packs: Oracle Change
Management Pack, Oracle Diagnostics Pack, Oracle Standard Management Pack,
and Oracle Tuning Pack. Each pack is fully integrated into the Oracle Enterprise
Manager Console framework.

Oracle Change Management Pack

■ Includes DB Alter, DB Capture, DB Diff, DB Propagate, DB Quick Change, DB
Search, and Plan Manager.

■ Tracks metadata changes in databases.

■ Eliminates errors and loss of data when upgrading databases to support new
applications.

■ Analyzes the impact and complex dependencies associated with application
change and automatically performs database upgrades.

■ Allows you to find the database objects that match a set of search criteria that
you specify.

■ Initiates change safely with easy-to-use wizards that teach the systematic steps
necessary to upgrade.

Oracle Diagnostics Pack

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Trace,
Oracle TopSessions, and Oracle Event Tests that are provided with the Oracle
Diagnostics Pack.

■ Monitors, diagnoses, and maintains the health of databases, operating systems,
and applications.  Both historical and real-time analysis are used to
automatically avoid problems before they occur.

■ Provides powerful capacity planning features that enable users to easily plan
and track future system resource requirements.
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Oracle Standard Management Pack

■ Includes Oracle DB Capture, Oracle DB Diff, Oracle Index Tuning Wizard,
Oracle Performance Manager, and Oracle TopSessions.

■ Monitors and diagnoses problems, tunes high impact indexes, and tracks and
compares changes in your Oracle environment.

Oracle Tuning Pack

■ Includes Oracle Auto-Analyze, Oracle SQL Analyze, Oracle Expert, Oracle
Index Tuning Wizard, and the Oracle Tablespace Manager.

■ Optimizes system performance by identifying and tuning major database and
application bottlenecks such as inefficient SQL, poor data structures, and
improper use of system resources.

■ Proactively discovers tuning opportunities and automatically generates the
analysis and required changes to tune the system.  Inherent in the product are
powerful teaching tools which train DBAs how to tune as they work.

■ Instills "Consultant Quality" tuning expertise into developers and DBAs and
increases their productivity.

Oracle Enterprise Manager Documentation
The Getting Started with the Oracle Standard Management Pack manual is one of
several Oracle Enterprise Manager documents.

Oracle Enterprise Manager base documentation

■ The Oracle Enterprise Manager Readme provides important notes regarding the
online documentation, updates to the software, and other late-breaking
information.

■ The Oracle Enterprise Manager Installation CD-ROM insert provides information
about installing Oracle Enterprise Manager.

■ The Oracle Enterprise Manager Administrator’s Guide explains how to use Oracle
Enterprise Manager, Oracle’s systems management console, common services,
and integrated platform tool.

■ The Oracle Enterprise Manager Concepts Guide provides an overview of the
Oracle Enterprise Manager.

■ The Oracle Enterprise Manager Configuration Guide explains how to configure
Oracle Enterprise Manager.
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■ The Oracle Enterprise Manager Messages Manual describes the Oracle Enterprise
Manager error messages and methods for diagnosing the messages.

Oracle Change Management Pack documentation

■ The Oracle Change Management Pack Readme provides important notes regarding
the Oracle Change Management Pack online documentation, updates to the
software, and other late-breaking information.

■ The Oracle Change Management Pack Installation CD-ROM insert provides
information about installing the Oracle Change Management Pack.

■ The Oracle Enterprise Manager Getting Started with Oracle Change Management
Pack manual provides an overview of the concepts and features of the Oracle
Change Management Pack applications.

Oracle Diagnostics Pack documentation

■ The Oracle Diagnostics Pack Readme provides important notes regarding the
Oracle Diagnostics Pack online documentation, updates to the software, and
other late-breaking information.

■ The Oracle Diagnostics Pack Installation CD-ROM insert provides information
about installing the Oracle Diagnostics Pack.

■ The Oracle Enterprise Manager Performance Monitoring and Planning Guide
provides an overview of the concepts and features of the Oracle Performance
Manager, Oracle Capacity Planner, and Oracle TopSessions applications.  It also
describes the Oracle Event Tests that are provided with the Oracle Diagnostics
Pack, which allow you to manage database, listener, and service types.

■ The Oracle Enterprise Manager Oracle Trace User’s Guide explains how to use the
Oracle Trace application to capture and use historical data to monitor Oracle
databases.

■ The Oracle Enterprise Manager Oracle Trace Developer’s Guide explains how to
instrument your application with Oracle Trace routines.

Oracle Standard Management Pack

■ The Oracle Standard Management Pack Readme provides important notes
regarding the Oracle Standard Management Pack online documentation,
updates to the software, and other late-breaking information.

■ The Oracle Standard Management Pack Installation CD-ROM insert provides
information about installing the Oracle Standard Management Pack.
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■ The Oracle Enterprise Manager Getting Started with the Oracle Standard
Management Pack provides an overview of the concepts and features of Oracle
DB Capture, Oracle DB Diff, Oracle Index Tuning Wizard, Oracle Performance
Manager, and Oracle TopSessions.

Oracle Tuning Pack documentation

■ The Oracle Tuning Pack Readme provides important notes regarding the Oracle
Tuning Pack online documentation, updates to the software, and other
late-breaking information.

■ The Oracle Tuning Pack Installation CD-ROM insert provides information about
installing the Oracle Tuning Pack.

■ Oracle Enterprise Manager Database Tuning with the Oracle Tuning Pack provides
an overview of the concepts and features of each of the applications in the
Oracle Tuning Pack. The applications include Oracle Auto-Analyze, Oracle SQL
Analyze, Oracle Expert, Oracle Index Tuning Wizard, and the Oracle Tablespace
Manager. A description of how these applications can work together to tune an
Oracle database is also provided.
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1
Overview

The Oracle Standard Management Pack is an optional set of applications that
provide advanced tools that allow you to monitor and diagnose problems, tune
high impact indexes, and track and compare changes in your Oracle8i environment.

The Oracle Standard Management Pack includes the following applications:

■ Oracle Performance Manager

Applies real-time, graphical Oracle and host monitoring through an extensive
array of customized performance charts.

■ Oracle Index Tuning Wizard

Proactively optimizes the indexes in your database environment.

■ Oracle DB Capture

Captures definitions of schema objects.

■ Oracle DB Diff

Allows you to easily compare schemas or databases.

■ Oracle TopSessions

Provides focused, performance diagnostics for Oracle sessions.

The following sections provide an overview of these applications.

Oracle Performance Manager
Oracle Performance Manager provides a system for capturing, filtering, and
presenting performance data for both the database and the host operating system.
Oracle Performance Manager offers:
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■ Graphical, real-time monitoring

With Oracle Performance Manager, database and host operating system
performance statistics are captured in real-time mode and can be viewed in
various tables and charts and in two- and three-dimensional presentations.

■ Predefined charts

Oracle Performance Manager provides a large collection of predefined charts
and tables organized into performance monitoring groups, including database
contention, I/O, load, memory use, instance metrics, parallel server
performance, and host operating system resource usage.

■ User-defined charts

Oracle Performance Manager can be used to graphically display any data
accessible through SQL or through the data collection framework. The
application allows you to create customized charts from user-defined scripts
which then can be added to the Oracle Performance Manager navigator tree for
easy access.

■ Customizable chart attributes and displays

With Oracle Performance Manager, chart properties and attributes can be
customized to change the type of the presentation. The type of chart can be
changed to bar, hierarchical, strip, pie, or table.

■ Chart drill down

Allows charts to be linked to other charts to gather detailed information.

■ Record and playback of charts

A user can capture a chart’s activity for analysis at a later date. Oracle
Performance Manager allows charts to be recorded and played back at your
convenience.

■ Parallel server monitoring

Oracle Performance Manager includes an extensive amount of parallel server
monitoring, including charts that monitor statistics such as block pings, file
I/O, sessions, users, and locks.

Oracle Index Tuning Wizard
The Oracle Index Tuning wizard quickly finds indexing problems that can slow
down the performance of your Oracle8 database. You can use the Index Tuning



Oracle TopSessions

Overview 1-3

wizard to evaluate and optimize indexes for situations when, for example, SQL
statement response time is slow.

The Index Tuning wizard considers your application type, for example, data
warehousing, table, and SQL statements for tuning.

The Index Tuning wizard then implements the generated recommendations or
saves the recommendations for later implementation. Each index recommendation
generated contains detailed information on exactly what operation needs to be
performed on the schema.

Oracle DB Capture
The DB Capture application guides you through the process of capturing the
definitions of a database (or a subset of a database) in a form useful to DB Diff and
other applications. DB Capture lets you specify the set of database object definitions
to capture, then captures those definitions in their current state.

DB Capture can capture object definitions in both of the following forms:

■ A baseline. The baseline stores definitions in a form that DB Diff can use. (A
baseline is an object that contains a set of database definitions captured at a
certain time.)

■ SQL DDL (optional). These SQL DDL statements can be used to create the
definitions in a new database or as input to CASE tools that accept SQL DDL
input.

Oracle DB Diff
The DB Diff application guides you through the steps of selecting two sets of object
definitions and then comparing them. The object definitions can be selected from
current databases or they can be selected from baselines created earlier with DB
Capture. If differences are found when the two sets of object definitions are
compared, DB Diff allows you to view the differences between the corresponding
object definitions.

Oracle TopSessions
Oracle TopSessions provides a focused view of database activity by database
session. Oracle TopSessions extracts and analyzes sample dynamic Oracle
performance data by session, automatically determining the top Oracle users based
on a specific selection criteria, such as memory, CPU usage, or file I/O activity.
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Note: All the applications that make up the Oracle Standard
Management Pack are members of other Oracle Enterprise
Manager Packs. For this reason, you may find mention of other
applications in the help, documentation, and user interfaces that
make up the Oracle Standard Management Pack.
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2
Introduction to Oracle Performance

Manager

Oracle Performance Manager is an Oracle Enterprise Manager application that
allows system and database administrators to monitor the Oracle database server,
the Oracle Rdb database server, and operating system performance data.

The performance data that can be monitored with Oracle Performance Manager
depends on the collection cartridges available on the system (host) on which you
want to monitor performance. Oracle Performance Manager provides many
cartridges that can be installed on a host, including:

■ Operating system performance statistics

■ Oracle database server statistics

■ Oracle Rdb database server statistics

When the operating system performance statistics cartridge is installed on a host,
Oracle Performance Manager can monitor the operating system performance
statistics described in the cartridge. Similarly, when the Oracle database server
statistics cartridge or Oracle Rdb database server statistics cartridge is installed on a
host, Oracle Performance Manager can monitor the Oracle or Oracle Rdb database
server statistics described in the respective cartridges.

If additional cartridges from Oracle Corporation or other vendors are installed on a
host, Oracle Performance Manager can monitor the performance statistics described
in the cartridge.

Note: Not all systems have all cartridges.
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Usage Scenarios for Oracle Performance Manager
Using Oracle Performance Manager, you can:

■ Monitor one or more services concurrently

■ View the monitored data in various chart formats, including strip, pie, bar,
table, and hierarchical

■ Set the refresh interval for a chart’s data

■ View multiple charts concurrently for each monitored service

■ View multiple charts in a single frame

■ Drill down from one chart to another

■ Choose the collected data and data sources of chart data to display

■ Display context-sensitive help for a chart, if the cartridge supplies the help

■ Play the recording of a chart, with fast-forward and pause features

■ Create and modify user-defined charts

Starting Oracle Performance Manager
Oracle Performance Manager can be started in any of the following ways:

■ On the Oracle Enterprise Manager console, point to the Standard Management
Pack drawer, then click Performance Manager.

■ On the Tools menu of the Oracle Enterprise Manager console, point to Standard
Management Pack, then click Performance Manager.

■ On the Start menu, follow the path: Start=>Programs=>ORACLE_
HOME=>Standard Management Pack=>Performance Manager. This displays
the Performance Manager Login dialog box.

Note: When you start Oracle Performance Manager from the
Oracle Enterprise Manager console, Oracle Performance Manager
connects to the Oracle Management Server using the same
credentials used to start the Oracle Enterprise Manager console.
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To run Oracle Performance Manager in repository mode, click the "Login to the
Oracle Management Server" option, enter the appropriate connect information
for your Oracle Management Server, then click OK. The specified Oracle
Management Server and its associated repository must already exist. You can
launch the Management Servers dialog box from the Oracle Enterprise Manager
console login dialog box to manage your list of recognized Oracle Management
Servers.

To run Oracle Performance Manager in standalone mode (not connected to the
Oracle Enterprise Manager repository), click the "Standalone, no repository
connection" option, then click OK.

You can now begin using Oracle Performance Manager.

Using the Oracle Performance Manager Main Window
The primary component of the Oracle Performance Manager user interface is the
main window, which contains two views.

The navigator or tree view appears on the left side of the main window. The
navigator displays the items that are pertinent to Oracle Performance Manager,
primarily services, cartridges, classes, charts, and recordings of charts.

When you select an item in the navigator, the right side of the main window
displays the property sheet for the selected item.

Note: ORACLE_HOME represents the oracle_home in which the
Oracle Standard Management Pack is installed.

Note: If the repository information for the Oracle Standard
Management Pack has not been created, Oracle Performance
Manager automatically updates the repository at connect time.
Similarly, if your repository version differs from the version of
Oracle Performance Manager and Oracle Enterprise Manager, the
repository will be upgraded automatically.

Also, you can run Oracle Performance Manager without being
connected to a valid repository. However, any recordings and
user-defined charts you make during the session will not be saved
when you exit Oracle Performance Manager.
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Default Display for the Navigator
By default, the Oracle Performance Manager navigator displays the services you
discovered using the Oracle Enterprise Manager console. See Figure 2–1 for an
example.

Figure 2–1 Navigator

The Network folder contains a folder for each service type, for example, Nodes and
Databases, for which there exists a Data Gatherer collection cartridge. When these
service type folders are expanded, the folder will expand to show the
corresponding services previously discovered through the Oracle Enterprise
Manager console. To connect to a service, expand its corresponding node in the tree.
You may be prompted for credentials if they are required to connect to that service.

In addition, the Recordings folder contains any recordings of chart data that exist.

Menu Options for the Navigator
The menu options for the navigator are as follows:

■ File
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– Connect to Service

If a service node or service container is selected, you are connected to the
service.

– Disconnect from Service

If a service node is selected, Oracle Performance Manager closes all charts
for that service and disconnects from the service.

– Add New Service

When a service container is highlighted in the navigator, Oracle
Performance Manager displays the appropriate dialog box for that service.
Enter the required information.

– Exit

Exits the Oracle Performance Manager application.

■ Recordings

– Stop Recording

Allows you to stop recording data. This menu item is enabled when a
recording is selected on the Recordings property sheet for a specific chart,
and a data recording session is currently in progress for that chart.

– Play Recording

Allows you to play previously recorded data. This menu item is enabled
when a completed recording is selected on the Recordings property sheet
for a specific chart.

– Remove Recording

Allows you to delete a recording from the repository. If you are not
connected to the repository, the recording will not be saved when you exit
Oracle Performance Manager. This menu item is enabled when a completed
recording is selected on the Recordings property sheet for a specific chart.

– Stop All Recordings

Allows you to stop all active recordings. This menu item is enabled only if
active recordings exist.

■ Charts

– Show Chart
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Displays the chart highlighted in the navigator tree.

– Add User-Defined Chart

Displays the New Chart property sheet. The Script page and the Data Items
page are displayed as part of the New Chart property sheet.

– Remove User-Defined Chart

Allows you to delete a user-defined chart from the repository. This menu
item is enabled when a user-defined chart is highlighted in the navigator
tree.

– Create Like User-Defined Chart

Displays the Create Like User-Defined Chart dialog box. This menu item is
enabled when a user-defined chart is highlighted in the navigator tree.

■ Help

– Using Help

Displays the Using Help topic of the Oracle Performance Manager help file.

– Contents

Displays the Contents page of the Oracle Performance Manager help file.

– Search

Displays the Search page of the Oracle Performance Manager help file.

– Window

When you select a panel, window, dialog box, or property page, this menu
option displays the help topic for the respective panel, window, dialog box,
or property page.

– Selected Item

When you select a class, chart, or data item in a panel or property page, this
menu option displays the help topic for the respective class, chart, or data
item.

– About Oracle Performance Manager

Provides version and copyright information about Oracle Performance
Manager.
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Toolbar Icons for the Navigator
On the toolbar, you will find the following buttons:

■ Connect to Service

■ Disconnect from Service

■ Add New Service

■ Add User-Defined Chart

■ Remove User-Defined Chart

■ Show Chart

■ ? (Displays the Contents page of the Oracle Performance Manager help)

To display a chart, select the chart in the navigator and click the Show Chart button
on the toolbar.

Displaying Charts
You can start a chart using one of these methods:

■ Selecting the chart in the navigator and clicking the Show Chart button on the
toolbar.

■ Selecting the chart in the navigator, which displays the chart’s property sheet.
To start the chart with the selected property sheet options, click the Show Chart
button on the property sheet.

■ Selecting a statistics class node, then selecting the chart on the right side and
clicking Show Chart.

Each chart or chart group is displayed in its own window, which is separate from
the main window. Each chart or chart group window has a toolbar to provide you
with control over the attributes of the chart or chart group. In the chart group
window, the toolbar applies to the active chart (the chart that has focus).

You can specify the collection interval for the chart data, which controls how often
Oracle Performance Manager updates the data in the chart display.

Selecting Collected Data and Data Sources
Depending on how the chart is defined by its cartridge, the chart’s property sheet
may allow you to select the collected data to display and the data sources for which
the collected data should be displayed. The collected data are the statistics that can
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be monitored and displayed in the chart. The data sources are the items from which
Oracle Performance Manager is able to collect the data. For example, the data
source of disk statistics may be disk1 or disk2, and the data source of file statistics
may be file1 or file2.

By clicking in the column next to the name of the collected data or the name of the
data source in the chart property sheet, you can specify whether or not to monitor
that collected data or data source and display it in the chart. When a green check
mark appears in the column, Oracle Performance Manager will display that
collected data or data source in the chart. If you click in the column again, the check
mark goes away, which indicates that Oracle Performance Manager will not display
that collected data or data source. You can toggle back and forth between
monitoring and not monitoring collected data or a data source by clicking in the
column. If the check mark is gray, it means Oracle Performance Manager will
display the collected data or data source and you are unable to change the selection
of this data.

If the chart definition contains default data source or collected data attributes, then
those items are preselected in the chart’s property sheet.

Monitoring Multiple Services Concurrently
You can view charts from multiple services concurrently by connecting to the
services from the navigator tree and starting the chart.

Viewing Multiple Charts Concurrently for a Service
Some cartridges include a chart group, which is two or more charts that are
displayed concurrently. You start a chart group the same way as you start a chart.

Charts in a chart group are displayed within a single window.

Selecting a Chart Format
A toolbar is displayed in every chart window. Click the button in the toolbar
representing the chart format in which the chart’s data should be displayed. The
available chart formats are:

■ Pie

■ Bar

■ Strip (or line chart)

■ Table
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■ Hierarchical

Selecting Chart Options
Oracle Performance Manager allows you to select filters to limit the data collected
for a chart. Not all filters are available for all charts.

You can select a limit to the number of data sources that are displayed. For example,
if the data sources are the processes on an operating system, you can query the
chart to display only 10 processes rather than all of the processes.

Also, you can query the Agent data gathering service to sort the data based on a
piece of data being collected.

These options can be useful for finding the top resource users. In the case where
processes are the data sources and the data collected is memory usage and CPU
usage, you can ask the Agent data gathering service to limit the number of data
sources to 10, and to sort by memory usage. Your chart would then show the 10
processes using the most memory. If you were to sort by CPU usage, you would get
the 10 processes using the most CPU instead.

Some charts can also give different views of the data. If that feature is available, you
will also be able to select a view of the data. An example of a data view may be the
current rate per second, or current rate per transaction for each piece of data
collected in the chart.

Chart-Specific Commands
Some charts have commands associated with them that can be executed by the
target service. An example of this is the Kill Session command that is available in
the Lock Manager charts for Oracle database services. If a chart-specific command is
available for a chart, it will appear in the popup menu displayed by clicking the
right mouse button while the cursor is positioned over a data item in a chart
display.

Drilling Down from One Chart to Another
Some charts have other drill-down charts associated with them. To display a
drill-down chart, use the right mouse button to click an item name in the chart
legend, the chart title, or a data item in a chart. A list of drill-down charts associated
with that chart item is displayed. If a list of drill-down chart names is not displayed
when you click the right mouse on a legend item, it means no drill-down charts are
associated with that item.
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Displaying Alternate Chart Types
When you are displaying monitored data in a chart, you can change the type of
chart. For example, if data is being displayed in a bar chart, you can choose to
display it as a pie chart.

To change the type of chart, in the toolbar click the button associated with the type
of chart you want.

Displaying Alternate Chart Orientations
You can display bar charts with either a horizontal or vertical orientation.

To change the orientation of the bar chart, in the toolbar click the button associated
with the orientation that you want.

Sorting Data in a Table Chart
When a chart is displaying data in table format, the sort order of the column data
can be changed by clicking the column headers in the table. The first click on a
column header sorts the data in ascending order, and a second click sorts the data in
descending order. Changing the sort order in the chart table does not affect the
data’s sort order on the server. To change the sort order of the data on the server,
use the Options page.

Obtaining Help for a Chart
From the chart or class Detail property sheet in the Oracle Performance Manager
main window, let the mouse pause over the chart or data item name and help will
display at the point of the cursor. Also, if a chart or data item is selected, the
Help=>Selected Item menu item will display help for that object in a separate
browser frame.

Accessing Performance Data Through an Intermediate Host
Oracle Performance Manager relies on the Agent data gathering service and the
collection cartridge to monitor a target database. Usually, the collection of the
performance data is done on the host where the database is located. Some cartridges
also allow you to connect to a service through an intermediate host.

Note: Help is not available for all objects.
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For platforms and situations where the Agent data gathering service does not exist
or where the collection cartridge does not exist on the target host, you can access the
performance data by connecting through an Agent data gathering service on an
intermediate host. This intermediate host could be the client host where the Oracle
Performance Manager is running, or any other host on the network on which the
Agent data gathering service is available and the desired collection cartridge is also
available.

When you first expand a service in the Oracle Performance Manager navigator tree,
you will be prompted with a dialog box containing logon credentials for the service.
This dialog box may also contain a field to specify the location of the data gatherer
which will be used to collect performance data. This field is defaulted to the host
where the service is located, but you may change this to be some other intermediate
host as previously noted.

Not all collection cartridges allow connection through an intermediate host.

Database Name Resolution
When collecting database performance statistics using Oracle Performance
Manager, note that the connection to the monitored database will be made by the
Agent data gathering service on the host specified in the connection/login dialog
box for that database.

The database name (or service) which is shown in that login dialog box, must be a
service name which can be resolved on the host where the Agent data gathering
service is located. A tnsnames entry or name server entry must be available for that
service on the host specified as the data gatherer location.

Recording Chart Data
Oracle Performance Manager allows you to record the data being monitored in a
chart. After a recording is complete, you can play it back. During playback, you can
pause and fast forward the recording, if you wish.

A chart recording can be located either under the Recordings folder or the Network
folder. You can manage chart recordings in the Recordings tree without connecting
to the service from which a chart was recorded. If you are already connected to
service under the Network tree, you can see a chart’s recordings by selecting the
Recordings tab in that chart’s Detail property sheet.
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Starting a Recording
You start a recording by performing one of the following steps:

■ With a chart highlighted in the navigator tree, click Record Chart on the chart’s
Data property sheet.

■ With a chart displayed in the Chart Display window, click the Record chart
button in the toolbar.

Oracle Performance Manager displays the Recording Parameters dialog box, which
allows you to enter:

■ Recording name

The name of the recording. The default name of the recording is the chart name.
This name does not need to be unique.

■ Recording directory

The directory where the recording is stored.

■ Recording interval

How often information is sent back from the server to the recording.

Stopping a Recording
Before you can play a recording, you must stop the recording. To stop a recording,
do the following:

1. Navigate to the Recordings folder or the Recordings tab in the chart’s Detail
page.

2. Select the chart being recorded.

3. In the corresponding property sheet, select the recording and click Stop
Recording.

You can now play the recording.

You can stop all recordings at one time. On the Recordings menu, click Stop All
Recordings.

Accessing a Recording for Playback
You can play completed recordings.

To play a recording, do the following:
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1. Navigate to the Recordings folder.

2. Select the chart you want to play in the navigator tree.

3. In the corresponding property sheet, select the chart and click Play Recording
(or on the Recordings menu click Play Recording).

4. In the Chart Display window, click the Play Recording button.

The Stop Playback, Pause Playback, Fast Forward, and Reset Playback buttons
become available in the playback window.

Removing a Recording
To remove a recording:

1. Navigate to the Recordings folder or the Recordings tab on the chart’s Detail
page.

2. Select the chart you want to remove.

3. From the Recordings menu, click Remove Recording.

Defining a New Chart
In addition to predefined charts, you can define your own charts based on
user-defined scripts. By defining your own charts, you can take a snapshot of data
at any given interval. After successful evaluation of the script, you can define the
operations to be performed on the data.

To define a new chart:

1. Expand the Databases folder in the navigator tree.

2. Expand the tree of the database for which you want to define a user-defined
chart.

3. Expand the User-Defined Charts folder.

4. Highlight the New User-Defined Chart entry and click the Add User-Defined
Chart button in the toolbar.

The resulting New Chart property sheet includes the Script page and the Data Items
page. You can display the Data Items page only after you have completed the Script
page.
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Script Page
Use the Script page of the New Chart property sheet to enter a script that will be
used to gather statistics for the chart you are defining.

Data Items Page
Use the Data Items page to customize how the resulting data from the script entered
on the Script page will be displayed in chart form. You can remove columns and
change the names of the columns. You can also define new columns with data
calculated from existing columns by using the Add/Modify Chart Data Items
dialog box.

Add/Modify Chart Data Items
This dialog box provides you with the opportunity to define new columns based on
the definitions of existing columns. You can select functions to be used on retrieved
data from the script. These functions are performed on numeric data. The functions
include:

■ Delta

Displays the current retrieved value minus the previously retrieved value.

■ Normalize

Displays the current retrieved value minus the initial value for that column.

■ Percent of total (PctofTotal)

Displays the current retrieved value as a percentage of the sum of all values in
the column.

■ Rate (Delta)

Displays the value of delta divided by the amount of time between the current
and previously retrieved values.

You can also perform operations on two columns. The operations are addition,
subtraction, multiplication, division, and percent divide.

The Oracle Performance Manager Help provides details on the functions and
operations available. The Help also provides an example of creating a user-defined
chart.
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Modifying Existing User-Defined Charts
To modify an existing chart you perform the same steps as outlined in the section
titled Defining a New Chart on page 2-13. The only exception is that the chart label
is already defined.

To modify an existing chart:

1. Expand the Databases folder in the navigator tree.

2. Expand the tree of the database for which you want to modify a user-defined
chart.

3. Expand the User-Defined Charts folder.

4. Click on the name of the chart you want to modify.

Modify the user-defined chart as needed.

Creating Like User-Defined Charts
You can copy user-defined charts from one service to another by using the Create
Like option. To copy a user-defined chart:

1. In the navigator tree, select the user-defined chart you want to copy.

2. Select Charts=>Create Like User-Defined Chart. The Create Like User-Defined
Chart dialog box displays.

3. Type a label for the new chart. Note that chart labels must be unique within a
service.

4. In the Service drop-down list, select the target service for the new chart.

5. Click OK.

In the Create Like User-Defined Chart dialog box, you can choose the Script or Data
Items page to view the attributes of the chart you are copying. However, you cannot
change the values of the attributes. Once the chart has been copied, you can select
the new chart in the navigator tree and make any desired adjustments.

Converting Old Performance Manager User-Defined Charts
If you created user-defined charts using Oracle Performance release 1.5.0 or earlier
(the Windows versions of Oracle Performance Manager), you can convert these
user-defined charts so that they can be used with Oracle Performance Manager
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release 2.0. Refer to the Oracle Enterprise Manager Configuration Guide for information
on how to perform the conversion.
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3
Introduction to Oracle Index Tuning Wizard

The Oracle Index Tuning wizard (hereafter referred to as Index Tuning wizard) is a
software application that identifies tables with inefficient indexes and makes
recommendations which will improve access to those tables.

The Index Tuning wizard:

■ Identifies tables in need of index changes

■ Presents its findings as written recommendations

■ Implements the recommendations for you

The Index Tuning wizard is intended for use with the Oracle cost-based optimizer.
The recommendations made by the Index Tuning wizard will optimize index usage
for the Oracle cost-based optimizer. Therefore, you should not use the Index Tuning
wizard for those schemas where rule-based optimization is used.

This chapter describes when to use the Index Tuning wizard, how to access the
Index Tuning wizard, and the Index Tuning wizard interface.

When to Use the Index Tuning Wizard
You can use the Index Tuning wizard to proactively maintain optimal indexes for
your database. You should run the Index Tuning wizard regularly to evaluate
whether index changes should be made to improve SQL query performance. The
Index Tuning wizard may recommend adding new indexes, changing existing
indexes, removing unused indexes, or changing the type of an index.

You should also use the Index Tuning wizard when one of the following situations
occurs:

■ A user has reported unacceptable response times for a query
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■ New applications have been added to the database environment

■ Existing application SQL has been modified

■ The database server has been upgraded to a new version

■ Table sizes within the database have increased substantially

Any of these factors may impact the indexing decisions for the database.

Accessing the Index Tuning Wizard
You can access the Index Tuning wizard in the following ways:

■ From the Oracle Enterprise Manager console palette

■ Through the Oracle Expert application

If you have the Oracle Expert application installed, you can launch the Index
Tuning wizard from the Oracle Expert Tools menu.

The Index Tuning wizard makes two database connections:

1. The Index Tuning wizard connects to its repository to access and update
database workload information required for index tuning.

2. The Index Tuning wizard uses the database credentials defined in Oracle
Enterprise Manager to connect to the target database for index tuning.

Index Tuning Wizard Interface
When you first access the Index Tuning wizard, you are greeted with a Welcome
screen that provides some of the advantages of using the Index Tuning wizard.

You will be lead through the following screens:

■ Application Type

■ SQL Statements

■ Evaluation Focus

■ Index Recommendations

Note: In either case, you must first select a database in the
navigator tree before launching the Index Tuning wizard.
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■ Index Recommendations - Details

■ Implementation Summary

Each of these screens is described in the following sections.

Application Type
On this screen, you choose the type of application that is primarily being used for
the target database being tuned: Online Transaction Processing (OLTP), data
warehousing, or multipurpose.

SQL Statements
The first time you run the Index Tuning wizard you will not see this screen unless
you have already collected a SQL history from Oracle Expert or Oracle SQL
Analyze. The Index Tuning wizard will automatically collect your SQL statements
from the SQL cache and save these statements in a SQL history for the next time
you run the Index Tuning wizard.

The Index Tuning wizard evaluates the SQL workload of the target database. On
this screen, you are given the option of using your existing SQL history or updating
your SQL history with new SQL statements from the SQL cache.

A SQL workload is the set of SQL statements that are responsible for the majority of
your database processing. This workload must include a good representative profile
of SELECT, INSERT, UPDATE, and DELETE statements. This workload is
automatically collected and saved during previous Index Tuning wizard sessions.

The workload can also be collected by using the SQL History feature of Oracle
Expert and Oracle SQL Analyze. If you have collected a SQL workload from either
of these sources and consider the workload to be sufficient, then select "no".

If you are unsure if the collected workload is sufficient, or if you know that your
workload has changed, then you should update your workload with a snapshot of
the current SQL cache by choosing "yes".

Note: There are three applications that use the SQL history
discussed in this section: the Index Tuning wizard, Oracle Expert,
and Oracle SQL Analyze. It is possible that you may have already
collected a SQL history from Oracle Expert or Oracle SQL Analyze.
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Evaluation Focus
On this screen, you have the opportunity to focus the index tuning evaluation. You
can let the Index Tuning wizard focus the evaluation on specific tables that are
being used most frequently by the highest impact SQL statements in your
workload. SQL statements are judged to be high impact based on their relative disk
I/O volume.

Optionally, you can select the schemas(s) you want tuned.

The purpose of the evaluation focus is to hide recommendations for schemas that
you are not responsible for tuning or you do not wish to tune at the current time.

When you first use the Index Tuning wizard, it is best to let the wizard focus the
evaluation so you will see an overall view of the problem areas. You can then focus
on specific areas of the database for which you have control.

Index Recommendations
From this screen you can:

■ Have the Index Tuning wizard generate the index recommendations, that is,
collect and analyze the data to provide the index recommendations.

■ Choose the index recommendations to be implemented.

Note that generating the index recommendations can take some time. The Index
Tuning wizard provides work-in-progress messages that keep you apprised of the
progress of the operation.

You can stop the generation at any time. The Index Tuning wizard deletes all the
created files in preparation for the next generation.

Once the recommendations are generated, use this screen to choose the index
recommendations you want to implement. The Details button provides additional
information about each recommendation. To activate the Details button, select a
recommendation.

The Next button displays the implementation screen once the generation has
completed.

Index Recommendations - Details
When you click the Details button on the Index Recommendations screen, the
Details screen displays. The Details screen provides information about why the
Index Tuning wizard made a particular recommendation.
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Implementation Summary
This screen allows you to implement and save the index tuning recommendations.
The possibilities are:

■ Implement recommendations immediately

■ Save the recommendations as an implementation script, an analysis report, and
an Oracle Expert tuning session. You can save the recommendations in any or
all of the formats available.

When you click Finish, the recommendations will be saved and/or implemented
according to the choices made.
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4
Introduction to DB Capture and DB Diff

The DB Capture and DB Diff applications are components of Oracle Enterprise
Manager that are provided with the Oracle Standard Management Pack.

With the DB Capture and DB Diff applications, you can track changes by:

■ capturing the definitions of a set of database objects using DB Capture

■ comparing the object definitions in one schema or database to another using DB
Diff

■ comparing object definitions in a schema or database to a previously-captured
state (baseline) of the same schema or database using DB Diff

■ comparing two baselines using DB Diff

Objects Supported by DB Capture and DB Diff Applications
The types of database object definitions that the DB Capture and DB Diff
applications support are:

■ cluster

■ database link

■ function

■ index

■ package

■ package body

■ procedure

■ profile
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■ refresh group

■ role

■ rollback segment

■ sequence

■ snapshot

■ snapshot log

■ synonym

■ table

■ tablespace

■ trigger and instead-of trigger

■ user

■ view

In this release, DB Capture and DB Diff do not support the following features of the
database objects in the previous list:

■ Object-oriented features:

– tables and snapshot logs that refer to:

* user-defined data types

* LOBs (any kind)

– object tables

– nested tables

– index-organized tables

– object views

■ Snapshots that are not read-only

For a more complete list that describes the level of support that DB Capture and DB
Diff offer for specific database objects and attributes, see the section in the Oracle
Standard Management Pack Readme that lists the features and attributes that are
currently unsupported by DB Capture and DB Diff.

The following sections provide overview information on the DB Capture and DB
Diff applications.
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Overview of DB Capture
The DB Capture application guides you through the process of capturing the
definitions of a database (or a subset of a database) in a form useful to DB Diff and
other applications.  DB Capture lets you specify the set of database object
definitions to capture, then captures those definitions in their current state.

DB Capture can capture object definitions in both of the following forms:

■ A baseline.  The baseline stores definitions in a form that the DB Diff
application can use.

■ SQL DDL (optional).  These SQL DDL statements can be used to create the
definitions in a new database or as input to CASE tools that accept SQL DDL
input.

Figure 4–1 shows the functional capabilities of DB Capture.

Figure 4–1 Functional Capabilities of DB Capture

You can start the DB Capture application in any of the following ways:

■ From the Oracle Enterprise Manager console, use either of these methods:

Note: When you first start the DB Capture or DB Diff application
against an Oracle Enterprise Manager repository, the Repository
Manager prompts you to create DB Capture and DB Diff extensions
to that repository.  Click OK to create the extensions.  Repository
Manager also prompts you in this way after an Oracle Standard
Management Pack or Oracle Enterprise Manager upgrade.

If the Oracle Enterprise Manager console is not running and you
start the DB Capture or DB Diff application from the Start menu,
you must specify credentials for an account with DBA privileges
that uses an Oracle Enterprise Manager repository.
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– On the Tools menu, point to Standard Management Pack, then click DB
Capture.

– Click the Standard Management Pack drawer, then click DB Capture.

■ On the Start menu, point to Programs, then to the name of the Oracle Home
where Oracle Enterprise Manager is installed, then to Standard Management
Pack, then click DB Capture.

The online help contains more information about the specifics of using DB Capture.

Overview of DB Diff
The DB Diff application guides you through the steps of selecting two sets of object
definitions and then comparing them.  The object definitions can be selected from
current databases or they can be selected from baselines created earlier with DB
Capture.  If differences are found when the two sets of object definitions are
compared, DB Diff allows you to view the differences between the corresponding
object definitions.

Figure 4–2 shows the functional capabilities of DB Diff.

Figure 4–2 Functional Capabilities of DB Diff

You can also generate a report in HTML format on the results of a DB Diff
comparison.  The report includes:

■ a description of what you compared

■ the comparison options you selected

■ a summary of the comparison results

■ the comparison tree and comparison details (optional)

You can start the DB Diff application in any of the following ways:

■ From the Oracle Enterprise Manager console, use either of these methods:
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– On the Tools menu, point to Standard Management Pack, then click Oracle
DB Diff.

– Click the Standard Management Pack drawer, then click DB Diff.

■ On the Start menu, point to Programs, then to the Oracle Home where Oracle
Enterprise Manager is installed, then to Standard Management Pack, then click
DB Diff.

The online help contains more information about the specifics of using DB Diff.
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5
Using Oracle TopSessions

This chapter covers how you use Oracle TopSessions, including the following
topics:

■ Before You Start Oracle TopSessions

■ Starting Oracle TopSessions

■ Oracle TopSessions Main Window

■ Obtaining an Overview of Session Activity

■ Viewing Details About a Given Session

■ Customizing the Session Information You Display

■ Exiting Oracle TopSessions

Before You Start Oracle TopSessions
Before using Oracle TopSessions, it is best to ensure that the following views exist
on the database instance:

■ V$SESSION

■ V$STATNAME

■ V$SESSTAT

■ ALL_TAB_COLUMNS

■ V$OPEN_CURSOR

■ V$SQLTEXT

■ V$LOCK
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■ SYS.DBA_OBJECTS

■ V$ROLLNAME

■ PLAN_TABLE

■ ALL_CATALOG

■ AUDIT_ACTIONS

The first four tables of the list are essential; Oracle TopSessions cannot run without
them. The rest of the tables are required to use certain features of Oracle
TopSessions; however, you can still run Oracle TopSessions without them.

The smptsixx.sql scripts have been provided by Oracle Enterprise Manager to create
the required tables and views on each database you want to connect to from Oracle
TopSessions. The xx in the file name identifies the version of the database against
which the script should be run. For example, if you have an Oracle 7.3 database,
you would run the smptsi73.sql script against it, and if you have an Oracle 8.0
database, you would run the smptsi80.sql script against it. The script for each
database version is located in the $ORACLE_HOME\SYSMAN\ADMIN directory.
Run these scripts from the SYS account. For more information about running these
scripts, see the section on setting up Oracle TopSessions in the Oracle Enterprise
Manager Configuration Guide.

If the ALL_CATALOG view or the AUDIT_ACTIONS view does not exist on a
database, run catalog.sql against the database from the SYS account. This script is
located in the $ORACLE_HOME\RDBMSxx\ADMIN directory.

Starting Oracle TopSessions
You start Oracle TopSessions as you would any typical Oracle Enterprise Manager
application.

By default, the top n sessions in the main display are sorted by the session logical
reads statistic. If you want to change the sort statistic and / or the statistic filter,
choose Options on the Session menu. This displays the Options property sheet, on
which you can customize the session information displayed in the main display. See

Attention:  See "Before You Start Oracle TopSessions" on page 5-1
if an error message appears when you attempt to start Oracle
TopSessions.
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"Customizing the Session Information You Display" on page 5-17 for more
information about using the Options property sheet.

Figure 5–1  shows the Oracle TopSessions main window and the Options property
sheet.

Figure 5–1   Oracle TopSessions Main Window

If you are monitoring multiple databases, it is possible to start multiple Oracle
TopSessions connections to multiple database instances. The system resources of the
management console are the only constraining factors.

Oracle TopSessions Main Window
As Figure 5–1  shows, the Oracle TopSessions main window includes the following
components:

Note: The options that were selected when you last exited Oracle
TopSessions are automatically loaded the next time you start Oracle
TopSessions. These options are saved in ORACLE_
HOME\SYSMAN\TEMP\TOPSESS.OPT.
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■ Title bar

■ Menu bar

■ Toolbar

■ Main display

■ Status bar

The following sections describe each of these components.

Title Bar
The title bar of the Oracle TopSessions main window displays the name of the
application and the database instance to which an Oracle TopSessions connection
has been established. If no connection to a database instance currently exists, the
message "No database connection" is displayed in the title bar.

Toolbar
The toolbar of the Oracle TopSessions main window contains icons representing
certain Oracle TopSessions menu items, including the following: Change Database
Connection, Refresh, Toggle Manual/Auto Refresh, Session Details, Kill Session,
Options, and Help. If no Oracle TopSessions connection to a database instance
currently exists, all tools except the Change Database Connection and Help tools are
disabled. If a database connection does exist, the Change Database Connection,
Refresh, Toggle Manual/Auto Refresh, Options, and Help tools are enabled.

The Refresh Mode tool performs the same function as the Manual and Automatic
buttons on the Refresh page of the Options property sheet. When the Refresh Mode
tool is not pressed (default), manual refresh mode is enabled. When the Refresh
Mode tool is pressed, automatic refresh mode is enabled.

Enabling automatic refresh mode with the Refresh Mode tool enables whatever
refresh interval is set on the Refresh page of the Options property sheet. To adjust
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this interval, go to the Refresh page itself. See "Customizing the Session Information
You Display" on page 5-17 for more information.

Status Bar
The status bar of the Oracle TopSessions main window can include the following
information:

Left section
When a menu item has been selected, an explanation of the menu item appears in
this section of the status bar.

Right section
Displays the time of the last data refresh of the Oracle TopSessions main display.

Oracle TopSessions Menu Bar
The menu bar of the Oracle TopSessions main window includes the following
pull-down menus:

■ File

■ View

■ Sessions

■ Help

File Menu
The File menu items allow you to create new database connections  and exit Oracle
TopSessions.

The File menu includes the following commands:

Attention: The length of time a data refresh requires varies,
depending on the number of sessions connected to the database
instance. A database instance with 700 to 800 sessions logged on
would require about 10 seconds to refresh. Thus, an instance with
perhaps 1,000 sessions logged on, when automatically refreshed at
the default 10 second interval, would be in perpetual refresh mode.
Thus, if you plan to use the automatic refresh mode, it is very likely
that you will want to adjust the refresh interval to reflect your
particular environment.
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Change  Database Connection
Displays the Login Information dialog box, enabling you to connect to a database
instance of your choice.

Exit
Exits Oracle TopSessions.  See "Exiting Oracle TopSessions" on page 5-20 for more
information.

View Menu
The View menu items allow you to refresh the main window display and to
show/hide the toolbar or statusbar.

The View menu includes the following commands:

Refresh
If manual refresh mode (default) is enabled, you can choose this command to
refresh (immediately) the session information displayed in the Oracle TopSessions
main window.

Toolbar
Allows you to show/hide the toolbar.

Status Bar
Allows you to show/hide the statusbar.

Sessions Menu
The Sessions menu items allow you to specify what session statistics will be
displayed in the Oracle TopSessions main display, and how that information will be
refreshed.  See "Customizing the Session Information You Display" on page 5-17 for
more information about these menu items.

The Sessions menu includes the following commands:

Details
Displays the Session Details window for the session selected from the Oracle
TopSessions main display. This menu item is disabled when no session in the Oracle
TopSessions main display has been selected.

Kill
Kills the user session selected on the Oracle TopSessions main display.

When a session has been killed, a red "X" marks the username of that session. This
symbol is like the red "X" on the Kill tool icon.
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Options
Displays the Options property sheet, from which you can specify the sorting
criterion, the refresh mechanism, and the number of entries for statistics displayed
in the Oracle TopSessions main window.

The length of time the data refresh requires varies, depending on the number of
sessions connected to the database instance. An instance with 700 to 800 sessions
logged on would require about 10 seconds to refresh.

If no Oracle TopSessions connection to a database instance currently exists, all of
these Session menu items are disabled.

Help Menu
The Help menu items allow you to obtain help on Oracle TopSessions menu items
or property sheets.

Contents
Displays an overview of the Oracle TopSessions help system.

Search for Help On
Displays an alphabetical list of Help topics.

Using Help
Displays information about using the Help system.

About Oracle  TopSessions
Displays the version number of this application.

Obtaining an Overview of Session Activity
Once populated with data, the Oracle TopSessions main display includes a
multi-column list of summary information for each session connected to the
database instance, or for each of the top n sessions, as measured by the selected sort
statistic. This information is obtained from the V$SESSION view, as follows:

SID
Oracle session ID for this session.

USERNAME
Oracle user name using this session.
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OSUSER
Operating system user name.

Sort Statistic
This fourth column varies, depending on the sort statistic you have selected.

COMMAND
Last Oracle command executed by this session.

STATUS
Status of this session: IDLE, ACTIVE, KILLED, or BLOCKED.

MACHINE
Identifier of the machine using this session.

PROGRAM
Name of the client program executing this session.

See "Customizing the Session Information You Display" on page 5-17 for
information about defining the top n sessions.

For information on the V$ views from which these statistics are derived, see the
Oracle Server Reference. For information on how to make use of these statistics, see
Oracle Server Tuning and Oracle Server Administrator’s Guide.

Using the Right Mouse Button on the Main Display
In the Oracle TopSessions main display, you can click on a username with the right
mouse button, and then select one of the following menu items:

Details
Displays the Session Details window for that session. See "Viewing Details About a
Given Session" on page 5-9 for more information.

Kill
Kills the selected session. This menu item works like the Kill menu item of the
Session menu.

Sorting the Order of Entries in the Main Display
By default, the value of the sort statistic determines the order of session entries in
the Oracle TopSessions main display. (The sort statistic is the fourth column of the
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multi-column list.) However, you can use any field in the list to sort the order of
displayed session entries, by clicking on any column header in the list.

Viewing Details About a Given Session
To obtain more information about a given session, you can drill down by double
clicking on an SID in the Oracle TopSessions main display. A Session Details
window for that session appears. This section covers the following topics:

■ Session Details pages

■ Session Details data refresh time

■ Viewing session details for multiple sessions simultaneously

Session Details Pages
The Session Details window includes the following pages:

■ General

■ Statistics

■ Cursors

■ Locks

To select one of these pages, click on the appropriate tab title near the top of the
Session Details window.

Session Details General Page
The General page of the Session Details window provides detailed information
about a session. This information is obtained from the V$SESSION view.

For information on the V$ views from which these statistics are derived, see the
Oracle Server Reference. For information on how to make use of these statistics, see
Oracle Server Tuning and Oracle Server Administrator’s Guide.

While the contents of the General page can vary, depending on the Oracle7 or
Oracle8 server release, for an Oracle 7.3 server, the General page contains the
following:

SADDR
Session address of this session.
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SID
Oracle session ID of this session.

SERIAL#
Serial number of this session.  Together with the SID, this number provides a
unique key for this session.

AUDSID
Auditing session ID.

PADDR
Address of the Oracle process using this session.

USER#
ID of the user using this session.

USERNAME
User name of the user using this session.

COMMAND
Last Oracle command executed.

TADDR
Address of the transaction state object.

LOCKWAIT
Address of lock waiting for; null if none.

STATUS
Status of this session: ACTIVE, IDLE, KILLED, or BLOCKED.

SERVER
Server type: DEDICATED, SHARED, PSEUDO, or NONE.

SCHEMA#
Schema user identifier.

SCHEMANAME
Schema user name.

OSUSER
Operating system user name.
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PROCESS
Process ID.

MACHINE
Identifier of the machine using this session.

TERMINAL
Operating system terminal name.

PROGRAM
Name of the client program using this session.

TYPE
Session type.

SQL_ADDRESS
Together with the SQL hash value, identifies the SQL statement that is currently
being executed.

SQL HASH VALUE
Together with the SQL address, identifies the SQL statement that is currently being
executed.

PREV_SQL_ADDR
Together with the previous SQL hash value, identifies the SQL statement that
executed previous to the SQL statement currently executing.

PREV_HASH_VALUE
Together with the previous SQL address, identifies the SQL statement that executed
previous to the SQL statement currently executing.

MODULE
Name of the currently executing module as set by calling the procedure named
DBMS_APPLICATION_INFO.SET_MODULE.

MODULE_HASH
The hash value of the above module name.

ACTION
Name of the currently executing action as set by calling the procedure named
DBMS_APPLICATION_INFO.SET_ACTION.
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ACTION_HASH
The hash value of the above action name.

CLIENT_INFO
Information set by the DBMS_APPLICATION_INFO.SET_CLIENT_INFO
procedure.

FIXED_TABLE_SEQUENCE
Number that increases every time the session completes a call to the database and
there has been an intervening select from a dynamic performance table.

ROW_WAIT_OBJ#
Object ID for the table containing the row ID specified in ROW_WAIT_ROW#.

ROW_WAIT_FILE#
Identifier for the datafile containing the row ID specified in ROW_WAIT_ROW#.
This column is valid only if the session is currently waiting for another transaction
to commit and the value of ROW_WAIT_OBJ# is non-zero.

ROW_WAIT_BLOCK#
Identifier for the block containing the row ID specified in ROW_WAIT_ROW#. This
column is valid only if the session is currently waiting for another transaction to
commit and the value of ROW_WAIT_OBJ# is non-zero.

ROW_WAIT_ROW#
Current row ID being locked.  This column is valid only if the session is currently
waiting for another transaction to commit and the value of ROW_WAIT_OBJ# is
non-zero.

LOGON_TIME
Logon timestamp for the session.

LAST_CALL_ET
Last call made during the session.

Session Details Statistics Page
The Statistics page of the Session Details window provides a large number of
performance statistics for the selected session. The particular statistics this page
displays can vary, depending on the Oracle server instance. These statistics are
obtained from the V$SESSTAT view.
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The selected category in the Category drop-down menu determines the statistics
that will be displayed for the current session.  To define a custom set of statistics to
display, click the Custom... button on the Statistics page.  Then use the Choose
Statistics for Display dialog box to select the set of statistics.  After you have chosen
a set of statistics, they are saved as the Custom category of statistics and the Custom
category is added to the Category drop-down menu.  Then, to select the Custom
category of statistics for display, select Custom from the Category drop-down
menu.  See "Choose Statistics for Display Dialog Box" on page 5-13 for more
information on choosing a custom set of statistics.

For information about the statistics that can be displayed for a session and the V$
views from which they are derived, see the Oracle Server Reference. For information
on how to make use of these statistics, see Oracle Server Tuning.

Choose Statistics for Display Dialog Box
The Choose Statistics for Display dialog box allows you to select a custom set of
statistics to display for a session.

The left tree view contains the list of statistics that are currently selected for display
in the Custom category on the Statistics page of the Session Details window.  The
right tree view contains the available statistics that can be selected for display in the
Custom category.  In the tree views, a + or - sign icon is used for the names of the
categories of statistics.  Click the + or - sign for a category of statistics to view or
hide the individual statistics in the category.

To move a category of statistics or an individual statistic from one tree view to the
other, double-click on the category or statistic.  Click OK when the left tree view
contains the set of statistics you want to display in the Custom category.  After you
have chosen a set of statistics, they are saved as the Custom category of statistics
and the Custom category is added to the Category drop-down menu on the
Statistics page of the Session Details window.  Then, to select the Custom category
of statistics for display, select Custom from the Category drop-down menu on the
Statistics page of the Session Details window.

You can modify the set of statistics in the Custom category by clicking the Custom...
button on the Statistics page of the Session Details window, then selecting a
different set of statistics using the Choose Statistics for Display dialog box.

The set of statistics in the Custom category are saved in $ORACLE_
HOME\SYSMAN\TEMP\TOPSESSC.INI.
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Session Details Cursors Page
The Cursors page of the Session Details window provides information about each
shared cursor in the shared SQL area for the selected session.

The Cursors page contains the following:

Show Cursors
Click on an item in this list box to display SQL statement(s) for the selected user
session. Options include:

Current Cursor: Displays the SQL statement currently executing.  This is the default.

All Cursors: Displays all SQL statements that have executed or will execute on the
database server for the selected user session.

Show Explain Plan
Click on this button to display the explain plan for the SQL statement in the Cursors
page display box which you have selected. See "Displaying an Explain Plan for a
User Session" on page 5-15 for more information.

Display box
Displays one or more SQL statements for the selected user session. If All Cursors
has been selected, the first SQL statement in the list is the statement currently
executing on the server for the session.

Attention: In order to view explain plans for SQL statements
accessing V$ views, you must log in as SYS. In addition, you must
have privileges to access the objects in the SQL statement for which
you want to view an explain plan.

Attention: If no SQL statement appears in this display box, but
you expect one to exist for the session, a problem may exist with an
important database table. See "Before You Start Oracle TopSessions"
on page 5-1 for more information.

Attention: Only SQL statements containing the commands
SELECT, INSERT, UPDATE and DELETE will produce explain
plans for you to view in this display box; any other SQL statement
will not produce an explain plan for you to view.
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Displaying an Explain Plan for a User Session
To display an explain plan for a user session, from the Cursors page of the Session
Details window, select a SQL statement and click on the Show Explain Plan button.
The Explain Plan For Session xx:y window appears.

The title bar of this window includes the SID (xx) of the session and the number of
windows opened on that session (y). This window includes the following elements.

SQL Statement
Displays the SQL statement for which you want to view the explain plan.

Explain Plan
The folders allow you to collapse or expand the level of detail of the explain plan.
This feature is particularly useful when analyzing long and/or complicated explain
plans.

Session Details Locks Page
The Locks page of the Session Details display provides information about locks
held or requested by a given session. This information is obtained from the
V$LOCK and V$ROLLNAME views.

For information about the V$ views from which these statistics are derived, see the
Oracle Server Reference. For information on how best to interpret and use these
statistics, see Oracle Server Tuning.

The Locks page includes the following list box:

Lock Types
Clicking on an item in this list box allows you to select the type of lock by which the
sessions will be displayed. Options include All Locks or Blocking/Waiting Locks.

The Locks page contains the following fields:

User Name
Oracle user name using the session.

Session ID
Oracle session ID for the session.

Note: The Expected Rows column only appears when an Oracle
7.3 database is being monitored.
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Lock Type
Type of lock, as follows: MR (Media Recovery); RT (Redo Thread); UN (User
Name); TX (Transaction); TM (DML); UL (PL/SQL User Lock); DX (Distributed
Xaction); CF (Control File); IS (Instance State); FS (File Set); IR (Instance Recovery);
ST (Disk Space Transaction); TS (Temp Segment); IV (Library Cache Invalidation);
LS (Log Start or Switch); RW (Row Wait); SQ (Sequence Number); TE (Extend
Table); and TT (Temp Table).

Mode Held
Mode in which the lock is currently held by the session, as follows: None; Null;
Row-S (SS); Row-X (SX); Share; S/Row-X (SSX); and Exclusive.

Mode Requested
Mode in which the lock is being requested by the process, as follows: None; Null;
Row-S (SS); Row-X (SX); Share; S/Row-X (SSX); and Exclusive.

Object Name
Name of the object, rollback segment, table or view, being locked. If the lock type is
TM, the object is a table or view. If the lock type is TX, the object is a rollback
segment.

Object Owner
Owner of the object that has been locked by the session. The session user, listed in
the Username field of the Session Details window General page, may be different
than the owner of the object being locked.

Object Type
Object type.

Object ID
Unique identifier of the object.

Resource ID 1
For certain types of locks, this value is the object ID or rollback segment number.
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Resource ID 2
Undocumented.

Session Details Display Refresh Time
Like the status bar of the Oracle TopSessions main display, the status bar of the
Session Details display also shows the refresh time for the information it displays.
This time reflects the refresh time of the Oracle TopSessions main display at the time
the Session Details display is created. Even when the Oracle TopSessions main
display is subsequently refreshed, the information in a Session Details window that
remains open during the main display refresh will not itself be refreshed.

Likewise, even though the refresh time in the status bar of the main window is
updated to reflect the most recent refresh, the refresh time in the status bar of an
open Session Details window is not updated simultaneously. Thus, the refresh time
in the Session Details window status bar continues to reflect the time the static
information in the Session Details window was captured.

Should you want to refresh the information for a given session in the Session
Details window, close the window and then double-click on the SID for that session
in the Oracle TopSessions main window. The resulting Session Details window will
reflect the latest refresh time of the Oracle TopSessions main display.

Viewing Session Details for Multiple Sessions
You can display, minimize (iconify), and maximize Session Details displays for
multiple sessions as you track down problems and work to resolve them.

Customizing the Session Information You Display
To customize how session information is displayed in the Oracle TopSessions main
window, choose Options from the Session menu. The Options property sheet that
appears includes the following pages:

■ Sort

Attention: If no information is displayed on the Locks page, it is
likely that no locks currently exist for the session. However, if you
suspect that locks exist, but no information is displayed on the
Locks page, a problem may exist with an important database table.
See "Before You Start Oracle TopSessions" on page 5-1 for more
information.
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■ Refresh

■ Count

To select one of these pages, click on the appropriate tab title near the top of the
Options property sheet.

Options Sort Page
Use the Sort page of the Options property sheet to specify how session information
displayed in the Oracle TopSessions main window will be sorted, and what time
interval the data will reflect. The Sort page contains the following:

Statistic Filter
Click on an item in this list box to specify the group of statistics from which to then
select a particular sort statistic in the Sort Statistic list box.

These groups of statistics are labeled as follows: Predefined, User (default), Redo,
Enqueue, Cache, Operating System, Parallel Server, SQL, Debug, Other, and All.

Selecting one of these items makes available a different group of statistics in the Sort
Statistics box. With the exception of the Predefined group, the mapping between a
statistic and its statistic filter group is derived from the CLASS column of the
dynamic performance table V$STATNAME.

The Predefined statistics are defined or calculated from statistics displayed on the
Statistics page of the Session Details display, as follows: CPU Usage (CPU used by
this session); File I/O (physical reads + physical writes); Memory (session uga
memory); Open Cursors (opened cursors current); User Transactions (user commits
+ user rollbacks).

Sort Statistic
Click on this list box to select the statistic by which the sessions displayed in the
Oracle TopSessions main window will be sorted. The contents of this list box vary,
depending on the Statistic Filter that has been selected.

Display Value
Current: Click on this button to specify that statistics displayed in the Oracle
TopSessions main window be based on the most recent data refresh.

Note: The options that were selected when you last exited Oracle
TopSessions are automatically loaded the next time you start Oracle
TopSessions. These options are saved in ORACLE_
HOME\SYSMAN\TEMP\TOPSESS.OPT.
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Delta: Click on this button to specify that displayed statistics reflect the difference
(delta value) between the most recent data refresh and the data refresh previous to
that.

Options Refresh Page
Use the Refresh page of the Options property sheet to specify how you want session
information displayed in the Oracle TopSessions main window to be refreshed. The
length of time the data refresh requires will vary, depending on the number of
sessions connected to the database instance. An instance with 700 to 800 sessions
logged on would require about 25 seconds to refresh.

The Refresh page contains the following:

Manual
Click on this button (default) to enable manual refreshing of the session information
displayed in the Oracle TopSessions main window. You can then use the Refresh
command from the View menu or the Refresh tool to refresh this information when
you so choose.

Automatic
Click on this button to enable automatic refresh of session information displayed in
the Oracle TopSessions main window; the Refresh Interval group of list boxes is
then enabled for use.

Refresh Interval
Click on the appropriate combination of the Seconds, Minutes and Hours list boxes
to specify the refresh interval for session information displayed in the Oracle
TopSessions main window. The default refresh interval is 10 seconds.

Attention: The refresh interval is the time interval measured from
the beginning of a refresh to the beginning of the refresh following
it. Thus, a database instance with perhaps 1,000 sessions logged on,
and being automatically refreshed at the default 10 second interval,
would be in perpetual refresh mode. Thus, if you plan to use the
Automatic refresh mode, it is very likely that you will want to
adjust the refresh interval to reflect your particular environment.
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Options Count Page
Use the Count page of the Options property sheet to specify the number of sessions
to be displayed in the Oracle TopSessions main window. The Count page contains
the following:

Display All Sessions
Click this button to display all sessions connected to the database instance. As this
option is very resource-intensive in almost all cases, Oracle Corporation
recommends that you use the default option Display Top N Sessions.

Display Top N Sessions
Click on this button (default) to display the top n sessions that meet the sort statistic
criterion specified in the Sort page of the Options property sheet. The default
number of sessions is 10. Click on the scroll box to the right of this button to specify
the value of n.

Exiting Oracle TopSessions
To exit Oracle TopSessions, choose Exit from the File menu. A dialog box is
displayed, confirming that you want to close your Oracle TopSessions session.
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